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Read Me First 
Welcome to Take Control of TextExpander, Second Edition, 
version 2.0, published in July 2015 by TidBITS Publishing Inc. This 
book was written by Michael E. Cohen and edited by Kelly Turner. 

This book covers how you can use version 5 of Smile’s TextExpander 
text-substitution utility for Mac and TextExpander touch 3 for iOS to 
make your writing, programming, and editing far more efficient and 
enjoyable. (TextExpander 3 and 4 users can download an older edition 
from this ebook’s blog; see Ebook Extras.) 

If you want to share this ebook with a friend, we ask that you do so as 
you would with a physical book: “lend” it for a quick look, but ask your 
friend to buy a copy for careful reading or reference. 

Copyright © 2015, Michael E. Cohen. All rights reserved. 

Sponsored by Smile 

This book was sponsored by Smile. Special thanks for an enjoyable 
project to Brian Bucknam, Greg Scown, Kelly Guimont, Maia Olson, 
Nat Osten, and Philip Goward. 

Updates and More
 

You can access extras related to this book on the Web (use the link in 
Ebook Extras, near the end; it’s available only to purchasers). On the 
ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or pur-
chase any subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 
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•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

If you bought this ebook from the Take Control Web site, it has been 
added to your account, where you can download it in other formats 
and access any future updates. If you bought it from Smile (or else-
where), you can add it to your account manually; see Ebook Extras. 

Note: To review basics that might help you understand this book 
better, such as finding System Preferences and handling contextual 
menus, read the free Read Me First: A Take Control Crash Course. 

What’s New in This Edition?
 

This edition covers TextExpander 5, which has been redesigned for 
(and which requires) OS X 10.10 Yosemite or later. It also covers the 
latest iOS app, TextExpander touch 3.5 (see Use TextExpander touch). 

Here are some the new features in TextExpander 5 and TextExpander 
touch that this edition covers: 

•	 Suggestions: This completely new feature is covered in Use 
Suggestions. 

•	 Inline Search: This recasting of the old Suggest Abbreviations 
command is described in Search Inline. 

•	 Cloud syncing: Learn new ways in which TextExpander can sync 
with cloud services, including iCloud Drive, in Sync with the Cloud. 

•	 JavaScript scripting: Script with JavaScript explains how to add 
executable script snippets in this language to TextExpander. 

•	 TextExpander touch keyboard: This addition to TextExpander 
touch brings TextExpander snippets into any app; read Use the 
TextExpander Keyboard to find out about it. 

In addition, lots of little bits of new information, too numerous to list, 
have been incorporated into the book. 
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Introduction 
It’s been several years since I first installed TextExpander on my 
Mac in preparation for writing the first edition of this book. At the 
time, I liked to run my Mac with as few add-on software utilities as 
possible, if for no other reason than to understand the experience 
that most Mac users have. 

However, TextExpander has changed my life—at least my working 
life. I write for a living, and a lot of the stuff I write about is hard to 
type—weirdly spelled, strangely capitalized—or all too easy to mistype. 
TextExpander has saved me from much of that: every time I type ttx 
instead of TextExpander, or ;js instead of JavaScript, or awatch 
instead of Apple Watch, or tco instead of Take Control, my work flows 
a little more smoothly, and every time I type Tonay instead of Tonya 
when corresponding with my editor (Tonya, you have no idea how 
often my fingers do that against my will), I save myself a heap of 
embarrassment. 

And then there are the emojis and the symbols that I can type without 
having to bring up the Mac Character Viewer, and the little productivi-
ty aids such as the boilerplate fill-in snippet I use when Apple issues 
its quarterly financial report and I help write the article summarizing 
the latest results for TidBITS (which, by the way, I can type as Tidbits): 
I can’t tell you how much time TextExpander has saved me with all of 
these things. 

Actually, I can tell you: TextExpander keeps statistics (click Statistics 
on the TextExpander window’s toolbar), and so I know that I have 
saved typing over a quarter of a million characters since I first installed 
the app, which comes out to me having saved more than a full working 
day of typing time at 80 words per minute. (I can also tell you the most 
often expanded snippet I have used this month…not surprisingly, it is 
ttx for TextExpander.) 
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Even though I still keep my Mac as free from add-ons as possible, 
TextExpander is one that I don’t want to live without. Revising this 
book has been a pleasure, since it helped reacquaint me with some 
TextExpander features I had forgotten (such as the hotkey to convert 
a text selection into a snippet quickly), as well as introducing me to 
some new useful ones: inline search, where have you been all my life? 

If you are an experienced TextExpander user, I hope this book helps 
you rediscover the great capabilities TextExpander offers that you may 
have forgotten. And if you are new to TextExpander, I hope this book 
helps you take full advantage of this delightfully useful app. 

There’s a good chance that TextExpander can change your life, too. 

Note: The first edition of this ebook is still available for folks who are 
running TextExpander 3 or 4. To download a copy, visit Ebook Extras 
and look in the Blog area. 
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TextExpander Quick Start 
If you have never used TextExpander, I suggest that you Meet 
TextExpander and Run the Snippet Creation Assistant. After that, 
explore how to Create and Use Complex Snippets. Those two chapters 
should give you a sense of what TextExpander is and what it can do; 
after that, feel free to read around as your fancy dictates. 

If you have used TextExpander before, you might benefit from review-
ing Customize Group Settings and Set Expansion Options, and be sure 
to read Don’t Forget These Fine Features!, ahead a page or so. If you’re 
an advanced user, you may find that Script with Snippets can take you 
even further than you have gone before. 

For all readers, I strongly suggest that you learn how to Back Up Your 
Snippets Automatically. 

Preliminary steps: 
•	 For tips on downloading and installing TextExpander, see Get 

TextExpander. 

•	 If you’re curious about what changed between TextExpander 4 and 
5, flip back to What’s New in This Edition?. 

•	 Get a running start: Run the Snippet Creation Assistant. 

•	 If you’re switching to TextExpander from another text-expansion 
utility, consult Add a Group from a File. 

•	 To get an overview of TextExpander’s two interfaces and start build-
ing your first, simple snippet, read Know Your Interfaces and Make 
and Use a Simple Snippet. 

Broaden your horizons: 
•	 To learn about the wide variety of snippets you can make, and to 

discover what they can do, read Create and Use Complex Snippets. 

•	 To keep your screen uncluttered while having ready access to 
TextExpander, read Manage Your Interfaces and Use Hotkeys. 
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•	 For ways to control when snippets expand, see Customize Group 
Settings and Set Expansion Options. 

•	 See how to expand your snippet collection when you Save, Add, and 
Import Groups and Use Suggestions. 

Get organized: 
•	 Corral and catalog your snippet collection; read Make Groups and 

Arrange Them and Organize a Group’s Contents. 

•	 Don’t get lost in a big snippet collection; read Find Your Snippets. 

Cover your assets: 
•	 To protect your snippet collection, see Back Up Your Snippets 

Automatically. 

•	 Don’t keep all your snippets in one basket; read Share and Sync 
Snippets to see how you can have them in two (or more) places at 
once. 

Flex your scripting muscles: 
•	 Drive other applications from a snippet when you Script with 

AppleScript. 

•	 Find out how to Script with the Shell to harness the power of Unix. 

•	 Do calculations, text manipulations, and even automate your Mac 
when you Script with JavaScript. 

Go mobile: 
•	 If you have an iPod touch, iPhone, or iPad, visit Use TextExpander 

touch to see how you can use your snippet collection on the run. 
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Don’t Forget These Fine Features! 
TextExpander has many useful features that even experienced users 
sometimes overlook. The following are among my favorites: 

✦ Enable/Disable TextExpander: You can make TextExpander 
ignore your abbreviations temporarily; it’s another one of the 
choices you have when you Use Hotkeys. 

✦ Inline Search: When you can’t quite remember a snippet’s 
abbreviation, just type what you think it is, or type any part of 
its content, and then press a hotkey to see a search window with 
a list of matching snippets. See Use Hotkeys and Search Inline. 

✦ Predefined groups: Smile provides a collection of snippet groups 
that are really useful, including the compendious TidBITS Auto 
Correct dictionary, a collection aimed at people who write HTML 
and CSS, and a compendium of Emojis , among several others. 
Check these groups out in Add a Predefined Group. 

✦ Auto-capitalization options: TextExpander can automatically 
capitalize sentences, and eliminate the common double-capital 
typo. See Set Auto-capitalization Options. 

✦ Adapt to Case of Abbreviation: A snippet can be capitalized 
when you want it, and be lowercase when you want it. Read 
Assign an Abbreviation. 

✦ Expand When All but Letters & Numbers Precede 
Abbreviation: This group setting lets snippets expand after both 
whitespace and punctuation; if you’ve ever wanted a snippet to 
expand after a parenthesis or a quotation mark but not in the 
middle of a word, this setting is for you. See Customize Group 
Settings. 

✦ Edit Last Expanded Snippet: Especially if you use TextExpander 
snippets to reply to customer queries, you may find that your 
snippets often need updating as products, policies, and services 
change, or when you find a better way of explaining something. If 
you’ve just inserted a snippet that needs an edit, you can quickly 
make the change; see Edit the Last Expanded Snippet. 
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Meet TextExpander 
The idea behind TextExpander is simple: it substitutes something you 
type (usually something short) with something else (usually longer and 
more complicated) in almost any situation where you can enter text. 
Although I’ll present a simple example in this chapter, TextExpander 
substitutions, called snippets, can be complex and extraordinarily 
helpful: they can include formatted text, images, the current date 
or time, fields where you fill in information on the fly, the clipboard 
contents, and more. They can even move the insertion point and run 
scripts. 

But first, some basics. In this chapter, I tell you how to: 

•	 Get TextExpander in case you don’t already have it. 

•	 Run the Snippet Creation Assistant to give you an initial set of 
customized snippets. 

•	 Know Your Interfaces so you can figure out when to use the 
TextExpander window and when to use the TextExpander menu 
bar icon. 

•	 Make and Use a Simple Snippet to give you some hands-on snippet-
slinging experience. 

•	 Learn the Types of Snippet Content and their typical uses. 

After that, you’ll be ready for the next chapter, where you meet the 
many kinds of snippets you can create, and master how to use them. 

Get TextExpander
 

It should come as no surprise that you’ll get the most value from this 
book if you have a copy of TextExpander installed on your Mac. You 
can obtain Smile’s TextExpander from the company’s site. 
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You can also purchase a Family Pack or Office Pack license from Smile 
should you need to install TextExpander on multiple machines that are 
used by more than one person; you can find details about the Family 
Pack and Office Pack in the TextExpander FAQ. 

If you just want to try TextExpander, you can obtain a free trial version 
from Smile’s site. 

Installation is nearly effortless: When you obtain TextExpander from 
Smile by downloading the trial version, you just unzip the downloaded 
file (if your Mac doesn’t do so automatically) and drag the application 
to your Applications folder. When you launch it, you may see a dialog 
asking you to give TextExpander permission to access your Contacts. 
This permission makes it a little easier when you use the Snippet 
Creation Assistant, described just ahead, but is not mandatory: you can 
click OK or Don’t Allow, as you prefer. 

Next you see both the TextExpander app’s main window and the 
Welcome to TextExpander window, as well as the Purchase/ 
Registration window (Figure 1). 

Figure 1: This window appears when you launch a new, unregis-
tered copy of TextExpander. 
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Create and Use Complex 
Snippets 

TextExpander’s capability to substitute a simple text string on the fly 
for something that you type is well worth the price of admission. But 
TextExpander snippets can contain more than just simple text, and 
they can do some cool things. 

You can create snippets that include formatted text and images. 
Moreover, using TextExpander macros, you can make snippets that 
include clipboard content, move your cursor, and type special keys 
like Escape and Tab. Snippets can even perform date and time math, 
combine several snippets into one, and generate fill-in forms. 

“Complex,” however, does not mean “hard”—complex snippets are 
easy to create and easy to use. 

And the uses, as you might imagine, are plentiful. 

Add Formatting and Pictures
 

As you saw in Learn the Types of Snippet Content a few pages back, 
one of the four types of snippet content is Formatted Text, Pictures. 
When you choose this item from the pop-up menu above the snippet 
Content field, the Formatting pop-up menu beneath the Content field 
is enabled (Figure 7) and the snippet Content field becomes ready to 
accept images. 

Figure 7: The Formatting pop-up menu is available when you 
create a Formatted Text, Pictures snippet. 
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Applying Formatting 
The two available submenus on the Formatting pop-up menu provide 
the standard text formatting commands that you probably have seen 
in many other OS X programs (Figure 8). 

Figure 8: The Font submenu (left) and the Text submenu (right) 
provide the standard formatting commands for Formatted Text, 
Pictures snippets. 

You can use the commands on these menus to format the text of a 
snippet in all sorts of sophisticated ways, adjusting text sizes, line 
layout, styles, kerning, and colors. The formatting menus effectively 
turn the snippet Content field from a plain text editor into a small but 
powerful word processor. 

For even more formatting control, choose Format > Text > Show 
Ruler. You can access style, justification, line spacing, list formatting, 
and tab stops from the ruler that appears (Figure 9). 
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Organize Your Snippets 
The more you use TextExpander, the more ways you figure out to use 
it—and that usually leads to the creation of more snippets. 

The small assortment of snippets that came with TextExpander by 
default are easy to remember, but sooner or later (sooner if you import 
some of the standard snippet collections that are available—you’ll find 
out about those in Save, Add, and Import Groups), you may find that 
you have dozens, or hundreds, or even thousands of snippets, and that 
your memory isn’t up to the task. 

Isn’t it a lucky coincidence that TextExpander has features that help 
you organize your snippets? 

In this chapter, I explain how to manage your snippets by group, and 
how to customize certain snippet settings that apply by group. 

Make Groups and Arrange Them
 

In TextExpander, snippets are organized into groups, which appear 
as folders in the Groups list at the left of the TextExpander window; 
the same groups also appear in the TextExpander quick-access 
menu, in the same order as they appear in the TextExpander window. 

Each group can contain an arbitrary number of snippets, from none 
to many thousands. To show or hide the snippets contained in a group, 
click the group icon’s triangle in the Groups list. 

When you first install TextExpander and Run the Snippet Creation 
Assistant, your snippets appear in a single group in the TextExpander 
window: My Snippets. This is fine when you can count the number of 
snippets you have on your fingers, but when you reach the point where 
you have to take off your shoes to count them, you’ll want more groups 
so you can divide your snippets among them. 
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Make a Group 
TextExpander makes it easy to add new groups to the Groups list. Use 
whichever one of the following three methods that appeals to you: 

• Type Command-Option-N. 

• Click the New Group button in the TextExpander window’s 
toolbar. 

• Click the Add button at the bottom left of the TextExpander 
window, and then choose New Group from the menu that appears 
(Figure 17). 

Figure 17: Create a new group from the Add pop-up menu. 

When you first create a group, its name is (Untitled), and its group 
icon appears beneath the last group that you had worked with or had 
selected in the Groups list. 

Rename a Group 
It’s easy to change the new group’s name when you create it, since 
its default name is selected in the Group Settings pane’s Name field 
(displayed on the right side of the TextExpander window): just type 
a new name. 

You can also rename an existing group, as follows: 

1. In the TextExpander window, click a group. 

The Group Settings pane appears in the right half of the window. 

2. Edit the text in the Name field. 

Note: I discuss the other options in the Group Settings pane later in 
this chapter, in Customize Group Settings. 
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Find Your Snippets 
It is the nature of snippet collections to grow larger and larger, and it is 
the nature of the human brain to lose track of what’s contained in large 
collections of stuff: this is why no one really knows what’s in the attic/ 
basement/sock drawer/garage/cabinet/self-storage locker. 

TextExpander, however, can offer you several kinds of assistance to 
help you quickly track down the snippet you want, even if you have 
managed to spawn thousands of the critters. 

Browse Your Snippets
 

It almost goes without saying, but the TextExpander window itself is a 
good place to start when you want to find a particular snippet and see 
what it contains. Figure 22 shows my TextExpander window with one 
of the snippet groups toggled open to reveal its contents. 

Figure 22: Browse your snippets in the TextExpander window with 
the arrow keys on your keyboard. 
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As you should know by now, when you select a snippet’s label in the 
Groups list, the right side of the window shows the snippet’s contents. 
While you normally use this feature to edit a snippet, you can also use 
it to browse your collection quickly: just press the Up and Down arrow 
keys on your keyboard to move from snippet label to snippet label, 
revealing the contents of each snippet in the right side of the window. 
When you arrow to a closed group folder in the Groups list, use the 
Right arrow key to toggle that folder open (the Left arrow key closes 
an open group folder). 

Note: The Page Up and Page Down keys scroll the Groups list in
 

the window, but do not change what you’ve selected in that list.
 
Similarly, the Home and End keys, respectively, reveal the top or
 

bottom of the Groups list, but leave your selection unchanged.
 

Furthermore, you don’t even have to arrow to a snippet to see its 
contents. As shown in Figure 22, previously, you can hover your 
pointer over a snippet’s label in the Group’s list to see a help tag that 
displays the snippet’s entire contents. 

You can also create print the snippets in any collection along with their 
abbreviations. Simply select the group folder, or any snippet in the 
group, and choose File > Print Group “group-name” (Command-P). 
This command prints a list showing each snippet’s abbreviation, 
followed by its contents, for the selected group. You can also print out 
your entire snippet collection by choosing File > Print All Groups 
(Option-Command-P), although this might churn through a ream of 
paper if you have many hundreds or thousands of snippets. 

Note: If you have chosen to hide the TextExpander icon in the dock 
(see Manage Your Interfaces), you can find the printing commands in 
the TextExpander window’s Tool pop-up menu. 

Tip: Use the PDF button in the OS X Print dialog to print your snippet 
collections to a PDF. You’ll save paper, and, with Apple’s Preview or 
a third-party PDF utility like Smile’s PDFpen application, you can also 
search the PDF. 
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Set TextExpander Options 
In the best of all possible worlds envisioned by Dr. Pangloss, all soft-
ware would be so perfectly designed that every program would satisfy 
every user without any need for modification or customization. In our 
less-than-Panglossian world, however, different people have different 
needs, expectations, and tastes. That’s why most Mac apps have a 
Preferences command on the app’s menu. 

With TextExpander’s preferences you can, among other things, adjust 
the application’s appearance, its text-expansion and correction behav-
ior, and whether it backs up your snippets automatically. 

Manage Your Interfaces
 

Unlike most applications that are right in your face as you use them, 
TextExpander does its job behind the scenes while you’re working 
with another application. Although there are times when you want to 
interact directly with TextExpander (and much of this book describes 
how, when, and why you do), usually when you’re using TextExpander 
you don’t need to see it—and probably don’t want to see it. 

TextExpander by default shows its icon in the Dock when it’s running 
and appears in the list of running applications when you Command-
Tab between them. But since it also provides an omnipresent quick-
access menu, you can choose the extent to which TextExpander takes 
up space in your Dock and your list of active applications: 

1. Choose TextExpander > Preferences > Appearance. 

2. In the Appearance pane, optionally (but recommended) select Show 
TextExpander in Menu Bar (Figure 26). 
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Figure 26: Here’s where you can give TextExpander an appearance 
makeover. 

This setting, which is enabled by default, shows or hides the
 
TextExpander 
 icon in the right half of the menu bar. As 
described in Know Your Interfaces, this menu provides an 
alternative way to get at your snippets and other TextExpander 
commands, even when the application is in the background. 

You can also use options beneath this setting to specify a different 
icon for the menu (if you’ve upgraded from an older version of 
TextExpander, you may prefer to see a familiar icon from bygone 
days) and to set the width of the menu: a wider menu means a wider 
Search Snippets field, which can be easier to read if you have a long 
search string (see Search and Filter Your Snippets). A wider menu 
also widens the snippet group submenus, making it easier to see 
each snippet’s contents. 

3. Select Hide TextExpander Icon in Dock. 

This is the big setting: when you check this box, TextExpander no 
longer appears when you press Command-Tab to switch between 
applications, and its icon no longer shows up in the Dock (unless 
you have manually put its icon in the Dock, and, even then, the icon 
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Create Snippets as You Go 
You’ve seen how to use the normal TextExpander application interface, 
complete with Dock icon and menu bar, and you’ve seen how to use the 
TextExpander quick-access menu interface, which offers most of 
TextExpander’s features and capabilities from a single icon menu. 

With OS X services and TextExpander hotkeys, however, you don’t 
even need to clutter your menu bar or Dock with TextExpander icons 
if you don’t want them: you can get much of the TextExpander func-
tionality you need right from your keyboard. 

This chapter tells you how to set up OS X services to enable the snippet 
creation and editing commands on the TextExpander quick-access 
menu. It explains how those commands work, and it shows you how to 
set up hotkeys so you can use those commands—and others—without 
reaching for your mouse or trackpad at all. 

Set Up Your Services
 

Pardon me while I make a brief excursion into OS X geekery. Trust me, 
I’ll be brief, and you don’t have to understand why you need to do what 
I’m going to tell you to do in this short section. In fact, you can skip the 
next paragraph of background information if it makes your head spin: 
just follow the steps that follow it, and all will be well. 

TextExpander’s quick-access menu provides commands for 
creating new snippets, including Create Snippet from Selection. This 
command makes a snippet from text that you’ve selected in another 
application, such as a phrase in a word processor or a passage on a 
Web page. TextExpander uses an OS X system service to communicate 
between the app in which you’ve selected the text and TextExpander’s 
snippet creation feature. TextExpander installs this system service the 
first time you run TextExpander. However, before you can use the 

78
 

Click here to buy the full 117-page “Take Control of TextExpander” for only $10!

http://tid.bl.it/tco-textexpander-sample


          
            

            
          

     
        

         

       

             
              

          
         

         
         

    

            
 

 

            
           

          

Create Snippet from Selection command, you must enable the service; 
while TextExpander can install the service, it can’t enable it on its own. 

Before you can use the Create Snippet from Selection command, do the 
following (if you don’t, you’ll see the dialog in Figure 33): 

Figure 33: This dialog appears the first time you attempt to create 
a snippet from a selection, if you haven’t yet turned on the required 
service. 

1. Choose Apple  > System Preferences > Keyboard > Shortcuts. 

2. In the column on the left, click Services. 

3. In the column on the right, scroll down to the Text group of 
services, click the triangle to open the group if it is closed, and then 
enable the Create TextExpander 3 Snippet service. (In case you’re 
wondering, the dialog and the Services list say “Create 
TextExpander 3 Snippet” because that service was developed for 
TextExpander 3 and it remains the same for TextExpander 5.) 

4. Close the Keyboard preferences window. 

From now on, you can use the useful Create Snippet from Selection 
command with impunity. 

Use Hotkeys
 

As you have seen in other parts of this book, with TextExpander’s 
quick-access menu you can access all of your snippets, create new 
ones, search them, and more. However, using the menu interface 
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Share and Sync Snippets 
Some of us can remember a time when it was a radical idea to imagine 
that an ordinary person could own a computer. Now, though, many 
people not only own one computer, but several, both stationary and 
mobile; for example, a desktop computer, a laptop, a tablet, a phone, 
and maybe even a few others (your author blushingly admits to having 
a half dozen computers of various kinds around his home as well as a 
few other retired machines stashed in his Vault of Antiquity—they 
seem to reproduce like tribbles). 

If you use multiple smart devices, and you employ TextExpander 
regularly on more than one of them, you might find it useful to share 
a master snippet collection among them. If so, read this chapter. 

Export Your Snippets
 

You read earlier, in Save a Copy of a Group, how easy it is to save a 
file containing a snippet group. Although there’s no equally easy way 
to save your entire snippet collection, you can certainly save the most 
important snippet groups to put on another of your machines— 
especially if you have a relatively small number of important snippet 
groups. 

Getting your snippet groups into TextExpander on a different Mac is 
also simple, and it is described in Add a Group from a File and in Add a 
Group from a URL. If you have access to a file server or a Web server 
that your computers can access, saving the groups that you need from 
one computer and adding them to another is certainly a viable way to 
spread your snippets among your machines. 

However, keep in mind the following caveats: 

•	 Snippet groups that you add from URLs cannot be modified unless 
you duplicate the group, and groups added from files can be modi-
fied only if you import them as local copies. 
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•	 Any changes that you make to the snippets on one machine won’t 
appear on any of the other machines, so unless you make changes 
only on one master machine, and replace the shared groups with 
updated copies when you do, your snippet groups will quickly fall 
out of sync. 

All told, saving and adding groups is best when you have a set of 
snippets that don’t change. It’s also a great way to distribute a common 
working set of snippets among coworkers. 

However, to be sure that all of your devices have the same set of 
snippets, saving and adding groups is not the best way to go. Instead, 
what you really want to do is sync your snippets using a cloud service. 

Tip: If you need to use text expansion in a Windows environment and 
would like to sync with your TextExpander snippets, check out Breevy 
from 16 Software. 

Sync with the Cloud
 

Cloud services for file sharing, such as iCloud Drive, Dropbox, and 
Google Drive, have become extremely popular, and it’s only common 
sense to use one of them to share your snippets among multiple 
devices. TextExpander understands common sense: you can sync your 
snippets from just about any cloud service that you can reach from 
your Mac. 

Note: Dropbox and iCloud Drive are the only two cloud services that 
currently work with TextExpander touch (see Use TextExpander 
touch). 

Here’s how TextExpander’s cloud syncing works: you point 
TextExpander at a folder on your chosen service, TextExpander copies 
your Settings.textexpander file to that folder, and, from that point on, 
TextExpander uses that file as your TextExpander settings file instead 
of the one found in ~/Library/Application Support/TextExpander/ 
Settings.textexpander. 
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Script with Snippets 
Your snippets don’t have to come from another planet or be bitten by 
a radioactive spider to acquire super powers. If you know how to write 
AppleScript, JavaScript, or Unix shell scripts, you can harness the 
power of those technologies in your snippets. 

TextExpander provides AppleScript snippets, JavaScript snippets, and 
Shell Script snippets. You just have to provide the code. 

Skip Previews for Script Snippets 
Although you can preview any snippet (see Preview Your Snippets), 
you should close the preview pane before viewing or editing a script 
snippet, as the act of previewing it can execute the script it contains. 
This could have unfortunate side effects when you view scripts that 
perform any automation in OS X. 

Script with AppleScript
 

AppleScript has been a part of the Macintosh experience since the 
days of System 7 (System 7.1.1 to be precise). AppleScript allows you to 
automate a number of tasks that would otherwise require the manipu-
lation of menus, buttons, and other elements of the Mac’s graphical 
user interface. 

If you know how to use AppleScript, you can leverage its power with 
TextExpander: put a script into a snippet and then invoke the script 
by typing the snippet’s abbreviation. 

Here are the steps to follow for creating an AppleScript snippet: 

1. In TextExpander, create a new snippet. 

2. Click the pop-up menu above the snippet Content field and choose 
AppleScript. TextExpander may insert a sample script into the field; 
if so, just delete it. 
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3. Type or paste your AppleScript code into the Content field. 

4. Assign the snippet an abbreviation and, optionally, a label. 

Figure 40 depicts a short, but useful, AppleScript snippet. It assumes 
that iTunes is open. When the snippet’s abbreviation is typed, it tells 
iTunes to play the current track if it is paused or to pause if the current 
track is playing. If there is no current track queued up, the script does 
nothing. 

Figure 40: An AppleScript snippet tells iTunes to play or pause. 

It’s a trivial script, sure, and not really necessary if your keyboard has 
a play/pause button on it. On the other hand, if you’re in the middle of 
typing, say, an email while listening to music, and the phone rings, all 
you have to do is type the snippet’s abbreviation and iTunes pauses. 
Furthermore, since the script returns an empty string, TextExpander 
replaces the abbreviation you typed with it, which effectively erases the 
abbreviation from the email. 

Tip: If you don’t know AppleScript, you can pick up the rudiments at 
the Mac OS X Automation site. 

Keep the following points in mind when you use AppleScript snippets: 

•	 TextExpander does not debug: TextExpander can run 
AppleScripts, but it does not provide any debugging or formatting 
capabilities. Before you create an AppleScript snippet, you should 
develop and debug the script in another environment, such as the 
Script Editor application, located in /Applications/Utilities. Once 
the script is developed, it’s easy to copy and paste it into a snippet. 
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Use TextExpander touch 
When you hit the road armed with your iPhone, iPod touch, or 
iPad, you don’t have to leave TextExpander behind. An iOS app from 
Smile, TextExpander touch, is available from the iTunes App Store for 
$4.99. The app provides much of the capability of the Mac application, 
but with its features tailored for the iOS fingertip environment. 

Naturally, the app can’t do everything that the Mac version can do: 
just as an iOS device doesn’t replicate all the capabilities of a tradition-
al computer, the iOS version of TextExpander doesn’t replicate all the 
capabilities of its Mac sibling. But it can do a lot, and, with Apple’s 
addition of custom third-party keyboards in recent versions of iOS, you 
can expand your snippets in almost any iOS app that allows typing by 
using the TextExpander touch keyboard. 

This appendix provides a brief look at how to Manage Your Groups, 
Use the TextExpander Keyboard, Make and Edit Snippets, and Ex-
change Snippets among Devices, as well as how to Work in the App 
to use its note writing and other capabilities. 

Manage Your Groups
 

Like its Mac sibling, TextExpander touch collects its snippets in 
groups, where you can arrange them and apply group-specific settings. 
To see your groups, click Group at the top of the TextExpander touch 
screen (Figure 44). 

99
 

Click here to buy the full 117-page “Take Control of TextExpander” for only $10!

https://itunes.apple.com/us/app/textexpander/id917416298?mt=8&at=10l5PW
http://tid.bl.it/tco-textexpander-sample


    

        

              
            

  

             
               

                
             

           

             
              

             
         
    

          
             

       

Figure 44: TextExpander touch provides separate views for
 
Groups and Notes.
 

You can do the following from the Groups list: 

•	 See the snippets in a group: Tap the name of any group to see 
the snippets that it contains. You can then Make and Edit Snippets 
in that group. 

•	 Arrange the groups in the list: Tap Edit at the top of the 
Groups list. Then, to move a group in the list, drag the Move icon 
at the right of a group’s name up or down. To delete a group, tap the 
group’s Delete icon and then tap Delete to confirm. Tap Done at 
the top of the screen when you have finished arranging your groups. 

• Add a new group: Click the Add button below the Groups list 
and then tap the kind of group to add. Aside from a new empty 
group, you can add one from a group shared over the local network, 
from a predefined group, or from a URL (see Add a Group and 
Share over a Local Network). 

• Edit a group’s settings: Tap the group’s information icon 
to see and alter a group’s settings (Figure 45). Tap Done on the 
settings screen to return to the Groups list. 
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Learn More 
You can learn more about TextExpander from Smile: 

•	 Smile’s TextExpander FAQ: Worth consulting. 

•	 The Smile blog: In the Category list on the side of this page, the 
entries about TextExpander are the ones to click. 

•	 Video tutorials: Video tutorials showing TextExpander in action are 
available here. 

•	 Smile support: Smile provides fast and friendly support. Submit 
your questions, feature suggestions, clever snippets, and other 
pointers here. 

Good places to go to learn more about advanced snippet techniques 
(and get some pretty advanced snippets, too): 

•	 BrettTerpstra.com: The blog entries tagged with “TextExpander” 
on Brett Terpstra’s site are cool and also very instructive. Brett also 
maintains a page with his collection of TextExpander tools. 

•	 And now it’s all this: Dr. Drang’s blog has a number of fascinating 
entries about script snippets; type TextExpander in the search field 
on the main page to see a list of entries. 
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About This Book 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments. 

Ebook Extras
 

You can access extras related to this ebook on the Web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy a 
subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

•	 Find out if we have any update plans for the ebook. 

If you bought this ebook from the Take Control Web site, it has been 
automatically added to your account, where you can download it in 
other formats and access any future updates. However, if you bought 
this ebook elsewhere, you can add it to your account manually: 

•	 If you already have a Take Control account, log in to your account, 
and then click the “access extras…” link above. 

•	 If you don’t have a Take Control account, first make one by follow-
ing the directions that appear when you click the “access extras…” 
link above. Then, once you are logged in to your new account, add 
your ebook by clicking the “access extras…” link a second time. 

Note: If you try these directions and find that your device is incom-
patible with the Take Control Web site, contact us. 
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Copyright and Fine Print 
Take Control of TextExpander, Second Edition 

ISBN: 978-1-61542-456-6 

Copyright © 2015, Michael E Cohen. All rights reserved. 

TidBITS Publishing Inc. 50 Hickory Road, Ithaca NY 14850, USA 

Why Take Control? We designed Take Control electronic books to help readers regain 
a measure of control in an oftentimes out-of-control universe. With Take Control, we also 
work to streamline the publication process so that information about quickly changing 
technical topics can be published while it’s still relevant and accurate. 

Our books are DRM-free: This ebook doesn’t use digital rights management in any 
way because DRM makes life harder for everyone. So we ask a favor of our readers. If you 
want to share your copy of this ebook with a friend, please do so as you would a physical 
book, meaning that if your friend uses it regularly, he or she should buy a copy. Your 
support makes it possible for future Take Control ebooks to hit the Internet long before 
you’d find the same information in a printed book. Plus, if you buy the ebook, you’re 
entitled to any free updates that become available. 

Remember the trees! You have our permission to make a single print copy of this 
ebook for personal use, if you must. Please reference this page if a print service refuses 
to print the ebook for copyright reasons. 

Caveat lector: Although the author and TidBITS Publishing Inc. have made a reasonable 
effort to ensure the accuracy of the information herein, they assume no responsibility for 
errors or omissions. The information in this book is distributed “As Is,” without warranty 
of any kind. Neither TidBITS Publishing Inc. nor the author shall be liable to any person 
or entity for any special, indirect, incidental, or consequential damages, including without 
limitation lost revenues or lost profits, that may result (or that are alleged to result) from 
the use of these materials. In other words, use this information at your own risk. 

It’s just a name: Many of the designations in this ebook used to distinguish products 
and services are claimed as trademarks or service marks. Any trademarks, service marks, 
product names, or named features that appear in this title are assumed to be the property 
of their respective owners. All product names and services are used in an editorial fashion 
only, with no intention of infringement. No such use, or the use of any trade name, is 
meant to convey endorsement or other affiliation with this title. 

We aren’t Apple: This title is an independent publication and has not been authorized, 
sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses 
terms that are registered trademarks or service marks of Apple Inc. If you’re into that sort 
of thing, you can view a complete list of Apple Inc.’s registered trademarks and service 
marks. 
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